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1 Version 9 Release History 

1.1 Changes in 9.0.2 

The 'maximum quantity orderable' value for an associated product is now correctly taken into account 
when ordering a component linked to that product. AC9-1135 

Stock levels of products in orders taken with a PSP are now decremented correctly when retrieving 
orders. AC9-1554 

If you open a pop-up window and then add to cart, you are no longer returned to the pop-up window 
after adding to cart. AC9-1585 

The totals on a Data Entry Report now appear correctly AC9-1555 

You can now import large hierarchical files into v9 without Actinic hanging AC9-1549 

A warning is no longer received on Actinic Payments when placing orders using Firefox PSP-134 

There are no longer problems decrypting orders in multi-user mode when logged in with a customer 
account that doesn't have a password AC9-1373 

There is no longer a crash when importing a large hierarchical file into an almost-empty store AC9-
1522 

Order Processors in a multi-user environment now have access to 'Marketing | Mailing Lists' 

 

1.2 Changes in 9.0.1 

A crash is no longer received in snapshot/upload after deleting a variable that has been set at the 
'Section' level. AC9-1246 

Google Analytics tracking code is now added in when registering designs via Dreamweaver. AC9-
1331 

The 'New Order' tab now appears when an Administrator logs into a Business Plus (multi-user) 
system when another Administrator is already logged in. AC9-511, AC9-1291 

PSPs can now appear in lists in the 'New Order'  form automatically AC9-1352 

You can now search for products in the 'New Order' form in both uppercase and lowercase and both 
will work fine. AC9-1381 

Shipping methods now change when you select a different 'State/Province' in the 'New Order' tab. 
AC9-1281 

The 'New Order' form now shows shipping costs correctly when the store uses 'Order Value' 
discounts and Shipping Categories. AC9-1382 

A crash is no longer received when entering a '0' for quantity in the 'New Order' form. AC9-1054 

Further security enhancements made to shopping cart and checkout scripts. AC9-647 

Back ordering now works correctly in 9.0.1 AC9-1258, AC9-1392 

US PSPs can now be set up correctly in the 'Payment & Security' tab. AC9-1319 

An error message is no longer received when converting an Actinic store to work with the Actinic 
Trial Server. AC9-1295 

The 'Catalog URL' in trial stores is no longer updated incorrectly with 'acatalog' when entering 'Web | 
Network Settings'. AC9-1372 

You can now change the password of a Business Plus user without affecting their ability to view credit 
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cards. AC9-1473 

When upgrading a site to 'Business Plus User' via 'Housekeeping | Upgrade' you no longer receive a 
'Cannot find synchronisation server' error. AC9-1167 

You can now license new sites using Business Plus User. AC9-1318 

You can now import snapshots into Business Plus that have a different synch server name in than the 
system it is being imported into. AC9-1322 

PayPal Pro now always upgrades correctly when going from v8 to 9.0.1 AC9-1334 

Various changes have been made to simplify the conversion to SQL (Enterprise) based Actinic. AC9-
833 

 

1.3 Changes in 9.0.0 

New features in v9 of Actinic Catalog, Business and Designer can be found in "Description of 
Changes to Actinic Since Version 8" (below). 
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2 Introduction 

2.1 About the Actinic Ecommerce Application 

Actinic Ecommerce (referred to as 'Actinic') is a desktop Windows program which enables you to 
design and publish an illustrated, on-line catalogue, take secure, encrypted orders over the Internet, 
and process these orders in-house.  

Actinic V9 continues to require minimal resources to build a successful store.  All you need is a dial-
up account with an ISP (preferably a broadband connection) and a web site with CGI access 
capability. 

With the enhancements made in v9, Actinic Catalog remains the most comprehensive low-cost 
ecommerce solution available today. Actinic Catalog includes everything a small business needs to 
design, build and control its own secure web store. 

Actinic Business delivers a more productive environment for users who have a reasonably high 
volume of sales going through their store and who wish to further automate their ecommerce 
procedures. It is also aimed at suppliers who deal online with other businesses (B2B) as well as 
retailers who want to give regular customers a more personalised service. Actinic Business builds on 
the comprehensive features in Catalog and allows the online merchant to integrate ecommerce into 
other existing business systems to create a true e-business. 

Actinic Designer offers a set of easy to use and flexible tools to enable internet professionals to create 
highly functional ecommerce sites on behalf of their clients. It offers multiple, unlimited site creation 
and licensing and integration with Macromedia Dreamweaver enabling external design of the store 
pages.  This product is primarily a site design tool, but it provides all the tools for order processing 
and the related features such as mailing list generation for demonstration purposes. 

Actinic Catalog and Business Clients provide a cost effective route for ecommerce professionals who 
use Designer to deliver Actinic functionality (without the web design capability) to their clients. 

Actinic Business Plus delivers all the features of Business along with the capability to create multiple 
sites that can take orders.  This product is primarily for merchants or designers who operate more 
than 1 store. It also allows multiple users on these sites to maintain the store and process orders.  

Version 9 is an upgrade from Version 8. 

2.1.1 New Product Range 

Actinic has merged Actinic Business Multi-Site and Actinic Business Multi-User into one single 
package – Actinic Business Plus. When you first license an Actinic Business Plus site, you will be 
asked whether you want to allow more than one user to access the site. If you choose to do this, the 
mult-user abilities will be activated. This option can be activated at any time from the 'File | Multi-
User Options' menu. 

The Actinic product range is now as follows: 

For web designers and their clients 

• Designer 

• Business Plus 

• Catalog Client 

• Business Client 

For Merchants 

• Express 

• Catalog 

• Business 
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• Business Plus 

2.2 Description of Changes to Actinic Since Version 8 

2.2.1 Tax Inclusive Pricing 

• You can now change your store into 'Tax Inclusive Mode', which means you can enter your 
prices including tax and Actinic will separate out the tax online. This is activated from 
'Business Settings | Tax'.  

2.2.2 'New Order' Form 

• Actinic Business, Business Plus and Actinic Designer users (not Actinic Catalog) have a 'New 
Order' tab, which allows them to enter new orders into the software quickly. This speeds up 
the process of taking orders over the phone. 

2.2.3 Product Options Wizard 

• There is now a wizard to step you through setting up a set of basic choice dependent prices, 
which can be stock monitored. This is activated from the 'Product Options' panel within your 
products. 

2.2.4 Start Here Panel 

• When you first start the software, you will see a 'Start Here' panel that links to pages of 
information about editing content, setting up the store and design. It includes links to relevant 
help topics and also a 'Design Wizard' to help with store site creation. 

2.2.5 Re-written Help System 

• The help system is now full of 'How Do I' style help topics, accessed by clicking the new 'How 
Do I' buttons, which are throughout the software. 

2.2.6 Google Analytics 

• It is possible to activate Google Analytics tracking of your visitors by going to 'Marketing | 
Google Analytics' and entering your Google Analytics username. 

2.2.7 Design Wizard 

• The 'Design Wizard' (accessed via the 'Start Here' panel) is a way of setting up the header 
areas and sidebars of your designs with the elements you want, appearing how you want, 
with the colours that you want. It will apply a basic theme customised to suit your 
requirements. 

2.2.8 Design Snapshot 

• Designers can now create a snapshot that only contains design elements (library contents, 
relevant images/files, colour scheme, site options settings) via 'Design | Export Design 
Snapshot'. This can be imported by going to 'File | Import Design'. Importing this file does 
not affect contents, Business Settings or orders.  

2.2.9 Postcode Lookup 

• There is now the ability to link your online Actinic store with a post-code lookup ability 
powered by 'Postcode Anywhere'. This is accessed via the 'Address Lookup' tab in 'Business 
Settings'. Business and Business Plus users can also user this ability on the 'New Order' tab 
when creating new orders. 

2.2.10 Design enhancements 

• There are now 'Split/Code/Design' buttons on the 'Design' tab to change the arrangement of 
the panels quickly. 

• There is also a 'breadcrumb trail' of layouts to show you the layouts that are 'above' the layout 
you are looking at in the design  
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2.2.11 Order Processing Enhancements 

• You can rearrange the columns in the 'Orders' tab. 

• A 'Next Action Date' field has been added for keeping track of what needs to happen when. 

2.2.12 Improved EPOS Link 

• The performance of EPOS link has been improved, and it is also possible to transfer details of 
completed orders to Actinic EPOS for common reporting. 

2.2.13 Other Enhancements 

• The default arrangement of the panels in Actinic has been changed in order to allow more 
room for viewing data in 1024x768 resolutions. 

• Content dialogues (i.e. products, sections, Site Options etc.) have now had tabs replaced by 
panels, accessed via a vertical list. 

• Error messages in the software have now been re-written to make them easier to understand. 

2.3 System Requirements 

2.3.1  Merchant PC 

• Microsoft Windows XP or Vista 

• 512 MB RAM (XP)/ 1 GB RAM (Vista) 

• At least 120 MB available on the hard disk 

• Intel Pentium 4, Intel Centrino, Intel Xeon, or Intel Core™ Duo (or  compatible) processor 

• Broadband or dial-up access to the Internet 

• Internet Explorer version 6 

• Minimum screen resolution of 1024x768 pixels (anything less and Actinic will not be 
displayed wholly within your screen) 

• Best viewed using a 65536 colour (or better) display 

2.3.2 Web site  

Your ISP must be running Windows NT, 2000, 2003 or UNIX, and provide Perl 5 or better, and a user 
writeable CGI directory. 

All products now require a set of Perl files called 'MD5'. These files implement 
encryption/decryption, which is required to support logging in to online customer accounts. Actinic 
Products include a local copy of MD5, however for improved performance, Actinic recommend that 
the ISP be asked to install "Digest-MD5", version 2.09 or later. 

2.3.3 Actinic FreeTrial Compatibility 

Compatible with FreeTrial hosts running script id nnnnnnnnn. 
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3 Installation Details 

3.1 Multiple Installations of Actinic  

Like previous releases of Actinic, it is not possible to install two copies of v9 on the same PC. 
However, once a copy of v9 has been installed and licensed, new sites can be licensed and maintained 
using the single software instance. 

3.2 Co-existence with earlier versions 

If you have an earlier version installed, they will be unaffected by the installation of v9 if you choose 
not to upgrade. Use of a second website to 'evaluate' the upgrade is permitted within the terms of the 
licence agreement so long as you do not operate both sites concurrently to take live orders. 

If you have an existing installation of v9 you will be offered the choice of upgrading it. 

V9 requires a different authorisation key to earlier versions. 
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4 Upgrading from Previous Versions of Actinic  

If you have a web site using an earlier version of Actinic, this site has to be upgraded to v9. v9 uses 
the same design architecture as v8, which is very different from previous versions (v7 and earlier).  

4.1 Upgrading from v8 

There are instructions for this in the main help in v9. Just install a standard v9 and then go to 
'Application Settings | Upgrading to New Versions' in the main help when you are ready to do the 
upgrade.  

4.2 Upgrading from v7 and earlier 

An automated upgrader will convert your old site(s) to the new architecture, but it is recommended 
that you familiarise yourself with the new design concepts and features in case you have to make a 
few manual changes after the automated upgrade.  The upgrader will handle the bulk of the changes 
for you. A few changes may be reported by the upgrader as needing attention but you will need to 
make the changes manually. Finally you will need to check through the appearance and operation of 
the upgraded site to make sure it is as you expect. A few manual amendments may also be required 
here. 

For these reasons it is recommended that you do the following: 

1. Install v9 without upgrading your existing site(s) and familiarise yourself with the new v9 design 
concepts and features. The design elements you are used to in v7 and earlier are not quite the 
same in v9. Templates have been replaced by layouts and layout selectors. Themes have now 
become independent sets of layouts, images and button sets. Your existing site image files get 
upgraded to custom themes and button sets (called something similar to 'Best Seller of Site1 
upgraded from version 7.0.6.0.0.0.GBGA' etc) – this happens even if you had not modified them. 
Some v7 themes have been retired but this doesn't not prevent your site upgrading satisfactorily. 

2. Upgrade your site and check it carefully in a test environment. There are three ways of upgrading 
an earlier version site: 

a. During the initial installation of v9, the installer program will ask you if you wish to 
upgrade an existing site. All previous versions of Actinic can be upgraded this way. 

b. If you have already installed v9, you can still run the v9 installer. This is the file called 
'setup.exe' that came on the CD or in the download file. Again it will ask you if you wish 
to upgrade an existing site. All previous versions of Actinic can be upgraded this way. 

c. Alternatively you can export a snapshot from your earlier version site. Then startup v9 
and import the snapshot into a v9 site. This only works on v6 or higher sites. Snapshot 
upgrades will not work with v5 or v4. 

 
In cases (a) and (b) ensure that you close your previous copy of Actinic before running the 
installer. The full site upgrade will only take place when you start up v9 and use the relevant 
site. 

Your earlier version installation will be unaffected by the upgrade process. 

3. The upgrade may produce some log files (it will tell you). These are placed in the  
Actinic v9\upgrader\”sitename” folder and called something similar to ScriptUpgrades 
8.0.0.0.0.0.GEXA.log and DesignTextUpgrades8.0.0.0.0.0.GEXA.log. The former lists any changes 
you made to Perl scripts. These changes are not automatically applied by the upgrader so you 
may have to manually reapply these changes to the new v9 scripts. The scripts haven’t changed 
much in v9 so this should be fairly straightforward. The DesignTextUpgrades log contains 
changes you made to certain items of design text, typically ones with embedded HTML. With 
each change in the log there is a suggested action you should take to apply a similar change in v9. 
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4. The next thing to do is go to the Design menu and choose the Check Coding Errors option. This 
will produce a report of all coding problems that may cause problems when generating your web 
site. Double-clicking on an error message will take you to the offending code in a layout. 

5. Keep a careful record of all changes you make as you will need to reapply them later in the 
process. 

6. Once you have fixed up any script changes, design text changes and coding errors it is time to test 
whether the site appears and functions as you would expect. One way of testing is to go to 'Web | 
Switch to Test Mode'. When you next upload, Actinic will upload your store pages to a sub-folder 
called 'test' within the 'acatalog' folder online. 

7. If you find areas where the upgrade has not given the same appearance or functionality as you 
had previously, and then firstly see whether these are small issues that you can correct yourself. 

8. If you have issues with the upgrade that you are unable to resolve manually and then call Actinic 
Support who may either guide you through the necessary changes or possibly give you new 
upgrade instruction files. In this latter case you will need to reapply the upgrade. 

9. When you feel confident that the upgrader (together with any small changes you need to make 
yourself) has satisfactorily upgraded your site it is then time to do the upgrade for real. Within 
your currently live copy of Actinic, download all the outstanding orders from your website. If you 
have a large volume of sales, you may want to go to 'Settings | Business Settings | Orders' and 
tick where it says 'Suspended' and upload. This will replace all your 'Add to Cart' buttons with a 
message saying 'CATALOG SUSPENDED'. After suspending online ordering, wait half an hour 
and download orders again to ensure there are none up there. This eliminates the risk of any 
orders being lost during the upgrade. Finally then repeat the upgrade and changes so that this 
time you have an up-to-date set of orders transferred together latest stock levels etc. 

10. Once you are happy the store is working correctly, you can switch out of test mode (if you used 
that approach for testing) and put the site live. To put your site live: 

• Go into your new site, and double-check that you are going to upload to the correct location 
by checking 'Advanced | Network Setup'. These settings should be identical to the settings in 
your old site. 

• Go to 'Web | Refresh Website' to upload the site. 

• Once it has uploaded successfully, go to 'Business Settings | Ordering' and un-tick 
'Suspended' in order to make the site active again (if you ticked this box earlier). 

• You can now update the site by going to 'Web | Update Website'. 
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5 Instructions for Use 

5.1 Main Help 

Actinic comes with extensive and integrated help. You can press the F1 key on your keyboard at any 
time to display the main help file. You can also click on the '?' button at the top right hand corner of 
each window and then click on an individual field on the screen to get specific, context sensitive, help. 
Use the Help menu for a complete explanation of using Actinic, including configuration details and 
creating the online store at your web site. 

5.2 Starter Guide 

The 'Getting Started Guide' can be accessed via 'Help | Starter Guide' option in Actinic. It is a PDF file 
designed to introduce the salient features of Actinic, and help you work through how to use them. 
They are a very good way to become familiar with the key features of Actinic. 

To access this guide, a copy of Adobe Acrobat Reader needs to be installed on your machine – this is 
available from http://www.adobe.com/ or http://www.adobe.co.uk/. 
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6 Technical Data 

6.1 Release Version Details 

6.1.1 Installation directory structure 

Actinic v9 The default installation directory. Holds files common to all sites, 
such as reports and help files. 

   BACKUP Any non site-specific files replaced during the installation are placed 
here. 

   Backup version Files from an earlier version site that have been upgraded 

   Extensions Files related to any software extensions e.g. Actinic Assistant for 
Dreamweaver  

   Formats Holds various default styles. 

      NavigatorSkins The files and configuration details of the Navigator. 

      Themes The files that constitute the themes, available via the 'Design | 
Themes' menu option. 

   OCCUpgrade Installation directory for the Payment Service Providers install 
program. Contains the master files. On startup, Actinic copies the 
relevant files to the current site. 

   Original The master set of general files used when sites are created. 

   SiteBackups Default location of all site and theme backups 

  SSLUpgrade Installation directory for the Shared SSL Service Providers install 
program. Contains the master files. On startup, copies the relevant 
files to the current site. 

   Starter Guide The browser-based introduction to the functionality. 

   Upgrade version Theme files associated with any upgraded sites 

My Documents 

   Actinic v9 

      Sites Locates all licensed sites. 

         Site1 Default site after installation. 

 

6.1.2 File version numbers 

Catalog.exe 9.0.2.0 IERA 

The main application program. 

ConnectionWizard.dll HBKA 

Supporting file for the Network configuration wizard. 

ActDiagnose.exe EDFA 

 ActDiagnostics.dll EDFA  

A diagnostic and problem solving tool. Do not use unless instructed to do so by Actinic's technical 
support staff. 

ActShipHand.ocx  FFFA  

An ActiveX control for configuring shipping and handling. 
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OCCControl.ocx EDFA  

AuthNetOCX.ocx EDFA  

DHOCCControl.ocx EDFA 

WUPayCash.ocx EDFA 

ISControl.ocx EDFA 

 

6.2  Install program version numbers 

ECSetup.exe IERA 

Installs Actinic. 

PSPSetup.exe IERA 

Installs the supported online payment service providers. 

SSLSetup.exe IERA 

Installs Shared SSL Service Providers. 

Mdac_typ.exe 2.6 

Microsoft data access installer. Ensures all ODBC-related drivers are correctly installed. 

Jet40SP3_Comp.exe 

Microsoft Access database engine (JET) update. Ensures all JET-related drivers are correctly installed. 

 

6.3 Restrictions 

6.3.1 Installing Database Components 

“Microsoft Data Access Components” (MDAC) and the Access Jet engine are provided on the 
installation CD. They are installed as part of the normal installation process but can be skipped by 
user selection.  If they aren’t installed then certain database operations within Actinic may fail 
meaning that normal operation isn’t possible. 

6.3.2 MD5 calculation 

Actinic Business and Developer install their own MD5 script and uses it if it can't find the MD5 Perl 
module installed on the web server. If the MD5 Perl module is already installed then it is used instead 
of Actinic's. 

Actinic's MD5 implementation is slower than the Perl module implementation (because it has to be 
written in Perl) so we recommend the ISP install the Perl module for improved browser performance. 

6.3.3 Internet Explorer earlier than version 6 

Actinic v9 uses some facilities provided in libraries installed with Internet Explorer.  In particular, 
Internet Explorer version 6 or later must be installed otherwise the software may fail to run properly. 
You may receive the error message: 

“Error Starting Program - The Catalog.exe file is missing export WININET.DLL:FtpCommandA” if 
you don’t have Internet Explorer version 6 or later installed. 


